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Imaging Computing Server   

What is the Imaging Computing Server? 

The Imaging Computing Server (ICS) is a software utility that distributes parts of a task between 
multiple, similar processing units to accelerate processor intensive operations.   

The ICS currently accelerates the following Volocity tasks: 

 Restoration (Iterative and Fast) 

 Ray tracing 

 Noise removal 

 4D measurements (excluding tracking) 

A complete ICS system will consist of several software components.  Hardware requirements for 
each component are given below in the “System Requirements” section. 

Software Components 

Control Service Receives jobs from the Client, distributes jobs to the nodes, 
manages feedback to the Client. 

Windows only service, no graphical user interface. 

Node Service Carries out processing, consists of Volocity modules required to 
carry out ICS accelerated processes. 

Windows only service, no graphical user interface. 

Client Volocity running on Windows or Mac OS X. 

Multiple clients may share the same ICS. 

Administration Configure and manage the ICS. 

Windows only. 
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The ICS Control Service, Node service and Administration tool software components are available in 
a single, unified, ICS installer 

System Administrator 
It is recommended that  one person manages the Computing Server and takes responsibility for 
configuring the system. This person is referred to as the “system administrator” in this guide. 

System Requirements 

The computer hardware market changes rapidly and, as a result, information about recommended 
system requirements also changes. Please refer to the Technical Note 440 published on the 
Support area of the web site,  

http://www.cellularimaging.com  

for the most up-to-date specifications. 

Nodes 
A node is a single machine, but it may contain multiple processors which in turn may contain 
multiple cores. 

Processor 2 (two) x Quad-Core Intel Xeon E5420 2.5GHz (e.g. Dell 
PowerEdge 1950 III) 

Operating System Windows XP Professional x64 Edition 

Windows 7 Professional x64 Edition 

RAM 8 GB 

USB port One free USB port for installation of dongle on the 
machine that will run the ICS control software. 

Free hard disk 
space 

20 GB minimum, 40 GB preferred 

 

The ICS nodes must be set to ‘never sleep’ and should not be switched off. 

ICS nodes must have adequate page file to carry out processing. We recommend setting a custom 
size where the initial and maximum page file is 20000 MB. 

Installation of the ICS can only be performed using an account on the computer with administrator 
privileges. Users of the Computing Server Administration tool require a Computing Server 
administrator account to be set up on the Computing Server. Users of Volocity do not require 
administrator privileges to connect to the Computing Server.  

http://www.cellularimaging.com/�
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The ICS is implemented using Windows services. A service is a program which can run in the 
background even if no other user is logged in. The ICS services start automatically when the 
machine on which they are installed is turned on. Each ICS node runs an instance of the Node 
service. 

Virtualization of the operating system installation is not recommended.  Virtualization is not 
recommended for performance critical applications such as the ICS.  Additionally some virtual 
environments are known to be unstable when running on multiple processors. 

Control 
The Control service should be installed on one of the nodes. This service distributes jobs to the 
other nodes. 

Administration 
The administration tool is available for Windows only and can be run on any PC which meets the 
minimum required specification. 

Processor Intel Pentium 3 or AMD Athlon XP Processor or better 

Intel Pentium, Intel Pentium 2 or AMD K6/K6-2 of any 
speed are not supported 

Operating System Windows 7 

Windows XP with Service Pack 2 

Windows Vista 

Windows 2000, Windows 98, ME and NT4 are not 
supported 

RAM 128 MB minimum 

Free hard disk space 100 MB for installation 

 

Network 
The Imaging Computing Server uses TCP/IP to communicate between the server and the client - the 
client computers must be able to contact the server using TCP/IP.   

The node running the Control service must have a static IP address.   

By default the server uses TCP port 15003, although this can be changed in the server application.   

 If this port is blocked by a firewall on the computer on which any software component of the ICS is 
installed there will be problems connecting clients to the ICS and/or administrating the ICS. 
Windows Firewall is enabled by default on many systems and the ICS service creates an exception 
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in this firewall when it runs.  For all other firewalls consult the documentation or your network 
administrator. 

The ICS will generate high volumes of network traffic as data is send between clients and nodes – 
for best performance the clients and nodes must be on a single high-speed network (e.g. a switched 
1000baseT Ethernet network).  

Client Machines 
Mac OS X and Windows clients can be served by the ICS.  The system requirements for a client 
computer depend on the type of application that that computer will run.  If the client machines are to 
share processing with the ICS nodes then they should be of a similar specification to avoid 
becoming a bottleneck in the processing.  See Technical note 263: System Requirements for 
Volocity on the website. 

http://www.cellularimaging.com/support 
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Installing the Imaging Computing Server 

1. Administrative privileges are required to install software.  Choose a computer to be 
the ICS control. Double-click the installer icon and follow the instructions on screen to 
install the Control, Node and Administration software. Note the IP address of this 
computer.  Plug the dongle into a free USB port on this machine, after running the 
installer. 

  

2. Install the ICS Node service on each of the node machines.  During the installation 
process you will be asked to enter the IP address of the Node that is running the ICS 
Control service.  Enter the IP address of the computer from step 1.   

The ICS will not work if it is prevented from sending information by a firewall.  
Windows Firewall is enabled by default on most systems and the ICS services will 
create an exception in the firewall when they run.  For all other firewalls the exception 
will have to be created.  See the section “Firewalls and Virus Protection” starting on 
page 29. 
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3. To start the Computing Server Administration tool and begin configuring the ICS, find 
the application in the Start menu, Start>Programs>Imaging Computing Server>ICS 
Administration.   

4.    If the ICS Control service is already running the following dialog will be shown. 

  

 Choose the option to Connect to the local server.   

5. If the ICS Control Service is not already running it can be started from the Computing 
Server Administration Tool.  If running  Windows 7 you will need to start the ICS 
Administration application with administrator privileges.  Right click on the ICS 
Administration item in the Start menu and select Run as Administrator.  

 At the prompt, select Start an ICS Control on this computer, which is the server 
running on the machine currently being used. 

  

 If this hint is not displayed, choose Start Server from the File menu.  

5. The server will then require a user ID and password to allow access. 
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The User ID ‘administrator’ with no Password should be used at this point. This is a default user 
setup on the ICS to allow initial access, before it is configured. You will be asked to set a new 
password to prevent unauthorised access to the server. The user, ‘Administrator’, is a member of a 
pre-existing group called ‘Administrators’. Any additional user, who is to be given ICS administration 
privileges, must be added to this group. Neither the ‘Administrator’ user ID nor the ‘Administrators’ 
group may be deleted. 

The ICS Administration will start, showing the Computing Server Status. 

Computing Server Status window 
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The address shown in the Computing Server Status window is the IP address of the machine 
running the ICS Control service. 

Once logged on to the server via the Computing Server Administration tool, configure the ICS, as 
described in “Configuring the Imaging Computing Server” on page 15. 

When the ICS Administration tool has been run as an administrator from the start menu it can also 
be used to start and stop the ICS. 

 

Remote Administration of the ICS 
It may be more convenient to administer the Computing Server from a machine that is not one of the 
nodes, for example your desktop machine.  If you wish to administer the Computing Server from 
another Windows machine, install only the ICS Administration tool.  You will be asked to enter again 
the IP address of machine that is running the ICS Control service. 

 

Choose the option to Connect to a remote server.  You will need to enter the IP address of the 
machine running the ICS Control service. 
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Important backup information 

The ICS stores the users and groups, plus usage logs for report generation in a database. This must 
be considered in the backup strategy for the system. The files are located as follows: 

Windows XP: 
C:\Documents and Settings\All Users\Application Data\Imaging Computing 
Server.  

Windows 7: 

C:\Program Data\Imaging Computing Server 

This folder is hidden by default, show hidden files, folders and volumes to reveal it. 

Installing client machines  

1. If you have received a Volocity CD, insert this into the drive of a client machine.  
You may also download the relevant installer for the product from the website: 
http://www.cellularimaging.com/downloads 

2. Double-click the installer icon and follow the instructions on screen.  
It may be necessary to perform additional installations of hardware drivers for devices 
to be controlled by the software. Without these drivers additional hardware will not 
work. 

3. Repeat this process for each of the applications and each of the client machines. 

The ICS must be configured for users and groups before client machines may log on. See 
“Configuring the Imaging Computing Server” on page 15 for details. 

 

http://www.cellularimaging.com/downloads�
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Configuring the Imaging Computing Server 

Overview 

Once the Computing Server is installed, users and groups must be created before any clients can 
log on.  

Users and groups can also affect what can be extracted from reports produced by the ICS. ICS 
administrators are advised to read the section on “Reports” on page 21, before deciding on their 
users and groups.  

Create users 

Only registered users may log on to the ICS. Everyone who is to be allowed to log on must be given 
a user ID. Passwords are optional. 

1. Select Users… from the Configure menu. There is already a user called 
‘Administrator’ defined. This is to allow administration of an ICS.  

                

2. Click Add….  Enter the user name in User ID: (and set up a Password, if required). 
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To make it easier to remember user IDs, we recommend a naming convention, such 
as: first initial, surname. 

4. At this stage we have not created any groups, so the Available groups: field may be 
left blank. We will collect users into groups at a later point in the configuration process. 
However, once groups have been created, new users can be made members of a 
pre-existing group in this dialog, at the same time as the User ID is created.  

5. Click Save. The new user now appears in a list in the Users window. 

6. Continue to add users until the required number have been added. Either click Add… 
or use Duplicate… to create a new user based on an existing one. 

Note: You may like to create a guest account by configuring a user called ‘Guest’. Do 
not set a password for this user. 
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Authentication against a domain  

It is possible for users to authenticate against a Windows domain. The computer on which the ICS 
Control software is installed must be integrated in the domain to make use of this feature.  To 
configure ICS user accounts for authentication against a domain, give each user the same ICS 
username as their domain username and choose “Use user’s password on the domain to 
authenticate”  

Create groups 

Groups help organize users for reporting purposes. 

1. Select Groups… from the Configure menu. 

  

 There will already be a group called ‘Administrators’ present. This allows 
administration of an ICS, using the Computing Server Administration Tool for 
Windows.  Any additional users who are required to be administrators of the ICS in 
this way should be added to the ‘Administrators’ group. 
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2. Click Add…. 

         

3. Enter a Group name and a brief Description of that group. For example, this could 
be the name of a lab or a project team. 

4. From the list of Available users, select all users who are to be a member of this 
group and click Add to add them to Users in group. 

5. Click Save to save the changes. 

Editing Computing Server Configurations 

You can now add new users and groups at any time. You can edit existing users and groups by 
selecting the required item in the relevant window and clicking the Edit… button. 
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Working with the Imaging Computing Server 

Computing Server Status 

If the Computing Server Status window is not visible on the screen select Show Status Window 
from the Window menu.  

The header part of this window shows the serial or dongle number of the server dongle, plus the IP 
address and port of the server machine. 

 

The top portion of the window summarises the setup of the ICS. 

The lower portion of the window will show information relating to client machines as they connect to 
the server, including the client IP address. 
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Computing Server Session Log 

The session log records the activity of the server application including all error messages. Error 
messages do not appear as alerts. Always check the session log, if a problem with the server is 
suspected. If you contact the Technical Support desk with a query, they may ask for a copy of the 
session log.  

1. Select Show Server Session Log from the Window menu. 

2. Use the buttons at the top of the Session Log window to save the session log to disk, 
or email the session log.   

 

                         

Save to disk Email 
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Jobs Users and Nodes 

For greater detail about the jobs that are running, users that are logged on and individual node 
performance view the relevant window.  Show Jobs, Show Users and Show Nodes are listed 
under the Window menu. 

Reports 

The log of information for reporting is continuous, it will be retained even if you quit and restart the 
ICS. 

1. Select New Report… from the File menu. 

2. Select the time frame of the report by setting From and To dates. 

 

3. Select a Report Type.  

          

 Choose Usage by user, or Usage by group to view ICS usage according to user 
ID or group. For each user or group the number of sessions and hours of CPU 
usage will be shown. Use this report to obtain information for billing individuals or 
groups for their time on the imaging system. 

 The Connection history report provides detailed analysis, for example, who was 
using the server at 3.15 on Monday 1st.  It will also show how much CPU time was 
used at each connection. 
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 The reports Users in each group and Groups for each user may be used as a 
record of the configuration of the system for reference. 

4. Click OK to generate a preview of the report. 

5. Once the report has been previewed it may be saved as a text file to export for further 
analysis or presentation, or it may be printed from the ICS application. Select the 
appropriate option from the File menu. 
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Unlocking additional licenses 

When you purchase licenses for additional nodes from PerkinElmer, you will receive an unlock code 
which, when entered in the appropriate location on the server application, will enable an increased 
number of nodes to connect to the control. 

1. Select Unlock Code... from the Configure menu. 

          

2. Enter the code provided, exactly as it appears in the communication sent from 
PerkinElmer, and click OK. 

3. In the Computing Server Session log you will be able to see the increased number of 
node licenses. 

4. Install the node software on the new computers and they will be added to the ICS. 
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Setup Network 

The default TCP/IP port used by the ICS is 15003. It is possible that there may be a conflict on this 
port on the server machine. This will be apparent to the network support personnel for your 
institution or building and they may ask you to change the port used by the ICS to solve the conflict. 
They may suggest an alternative port number to use. 

1. Select Setup Network… from the Configure menu. 

 

2. Change the TCP/IP Port number in the dialog.   

3. Click Save to activate the change.  All of the associated nodes are updated to the new 
TCP/IP port. 

4. After changing the TCP/IP port of the ICS please advise all users of the server that 
they will need to enter an alternative port number in the Computing Server preference. 

Data transfer is by default directly between the clients and nodes for speed, if however this form of 
communication is not reliable force all data to go via the ICS Control.  This will substantially increase 
the network overhead.  



USING THE IMAGING COMPUTER SERVER 

  July 2004 25 

Using the Imaging Computer Server 

Volocity clients must be configured to use the ICS to accelerate eligible processes.  

1. Start Volocity. Select Preferences… from the Edit menu (Windows) or the Volocity 
menu (Mac OS).   In the Preferences dialog select Servers. 

 

2. Click the “+” (plus) sign to configure a new server connection. 
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3. Set the Type: to Imaging Computing Server.  Enter the address and port details for 
the computer running the Control Service.  Enter a User ID and Password for the ICS 
at this address. 

4. Click the Options… button to configure the use of the ICS by this Volocity client. 

 

 Use the Imaging Computing Server all jobs will be sent to the ICS 

 Use the Imaging Computing Server and this computer to allow your computer 
to work on your jobs alongside the ICS. Select this option only if your computer is 
of comparable or higher specification to the node computers.  A lower specification 
computer will create a bottleneck in the processing and may slow the overall 
process down.  A comparable computer will increase the speed of processing.  If 
there are jobs queued on the ICS ahead of yours, progress will still be made on 
the local computer. This computer will only be used as a node for processes 
started on this computer. 



USING THE IMAGING COMPUTER SERVER 

  July 2004 27 

 Process all operations on this computer the ICS will not be used. 

Every process that can be accelerated by the ICS will require the data to be broken down into jobs.  
The way the data is broken down i.e. the definition of a job varies depending on the supported 
operation. 

Iterative Restoration 
1 job is 1 image (1 channel, 1 timepoint) 

Or  

1 job is 1 block if Break image into blocks is enabled in the restoration dialog. 

Block size is calculated using RAM/processor determined using total amount of RAM 
in all nodes divided by total number of processors in all nodes. 

Remove Noise 
1 job is 1 timepoint or channel (e.g. a 10 timepoint series with 2 channels would result 
in 20 jobs).  

Measurements 
1 job is 1 timepoint 

Ray Tracing 
1 job is 1 tile in the raytraced image. 

Upgrading the ICS 

PerkinElmer has a policy of regular updates to all products.  Upgraded versions of the ICS will affect 
the ICS Control and Node services and the ICS Administration tool.  It will therefore be necessary to 
install upgrades on all the machines involved. 

Upgrading the Imaging Computing Server is simple: 

 Download the ICS installer. Run the installer on each of the nodes updating the 
Node and Control services as appropriate. 

 Run the ICS installer on each machine where the Administration client is installed 
to update the client 

 All the information relating to users, groups and configurations is stored on the 
server, so there is no need to modify the client installations in any way. 
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Note: It is important that the latest version of the ICS and Volocity is used on all client 
and node computers. New versions of the ICS may not be compatible with old 
versions of Volocity and vice-versa. 
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Firewalls and Virus Protection 

Firewalls 

In order for the ICS Administration application to communicate with the Control application and for 
data to be transmitted between the client and the nodes it must be possible for these applications to 
cross any firewall on the system.  An exception in Windows Firewall for Windows XP and Windows 
7 is made automatically when the ICS services start.  For all other firewall implementations you will 
need to ask your network administration for assistance. 

Virus Protection 

Real-time anti-virus scanning on client and node computers will severely impair performance.  Real-
time scanning must be disabled for Volocity and ICS applications. 

The ideal solution is to disable real time-protection or scanning for the ICS. 

If this is not possible disable real-time protection for Volocity data files, since these are the file types 
that the ICS will be processing.  Volocity file types are: 

 *.mvd2 

 *.aisf 

 *.aiix 

 *.atsf 

 *.dat 

Only if neither of the first two options is possible should real-time protection by the anti-virus 
software be disabled.  This will disable real-time protection for the whole computer. 

Consult the documentation for your anti-virus software for specific instructions on disabling real time 
anti-virus protection. 
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Troubleshooting 

Windows dongle-related errors 

The ICS is dongle protected. The USB dongle requires a driver to operate and this driver is installed 
by the ICS installer.  

IMPORTANT: You must not plug the dongle in until after the Computing Server has been installed 
for the first time. If you plug the dongle in before the installation program finishes, it will not be 
detected by Windows.   

When starting the Imaging Computing Server 
You may see the following error message when trying to start the ICS: 

‘The command could not be completed because the dongle was not found (2600)’ 

To correct this problem: 

1. Right-click on the "My Computer" icon and select Properties. 

2. Click Device Manager and look for an icon with a yellow exclamation mark next to it 
called "Unknown USB Device", or similar.   

3. Click this icon, click Remove, and then click Refresh. Windows should then redetect 
the dongle and install the correct driver. 

Installing subsequent versions of the ICS does not require removal of the dongle. 

Starting and Stopping ICS Services 

If, for any reason, the ICS node and/or ICS control services do not start automatically the services 
will have to be started manually. 

Indications that ICS node or control services are not running include: 

 Computing Server Status shows fewer nodes than expected are running 

 Control service can’t be started from the ICS Administration tool 
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 Volocity returns the error message ‘The command could not be completed 
because the Computing Server has no nodes’ 

To manually start or stop ICS services go to the Services Control Panel.  This may be listed under 
System and Security> Administrative Tools.  If they have been installed the ICS Control Service 
and ICS Node Service will be listed. 

 

Click the relevant option to start or stop the service. 
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